
Y O U R  G U I D E  T O  A L L  T H I N G S  Y E A R B O O K



REP
• Design ideas, including cover and theme
• Curriculum and training
• Sample books
• Staff organization
• Pricing questions

CSA (CUSTOMER SERVICE)
• Deadline information
• Shipping information
• Turning on cover templates

TSA (TECH SUPPORT)
• Assistance with book settings
• eDesign and eBusiness setup
• Submitting pages
• Uploading PSPA/PSPI file 
• Uploading your Name List

WHO 
TO 
CALL

THEY’VE GOT YOUR BACK,  
SO ALWAYS HAVE THEIR 
INFO ON HAND.

YEARBOOK REPRESENTATIVE (REP)

Name:	

Email:	

Phone:	

CUSTOMER SERVICE ADVISER (CSA)

Name:	

Email:	

Phone:	800.255.6287

TECHNICAL SUPPORT ADVISER (TSA)

Phone:	877.362.7750

Submit a customer support form: 
herff.ly/techsupport

SCHOOL PHOTOGRAPHER

Company Name: 

Contact Name: 

Email:	

Phone:	

DETAILS TO KNOW BEFORE YOU CALL YOUR TSA OR CSA:

Your job number: 
Your school has a unique number to identify your files within the 
plant so they can find you easily. 

Operating system: 
What type of computers does your staff use and what platform?

Web browser: 
Which web browser do you use? They all operate differently, 
so knowing your preferred browser will help answer questions.

eShare code: 
This code is for students to use while sharing photos for the book.

WHAT CAN 
THEY HELP 

YOU WITH?
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MYHJYEARBOOK.COM 

MYHJYEARBOOK.COM 

LEARNYBK.COM

BOOKMARK 
IT

MYHJYEARBOOK .COM LOGIN CREDENTIALS

My username: 

My password: 

MYHJYEARBOOK.COM
This is your portal to all things yearbook, including eDesign 
and eBusiness. Also important to InDesign users, this site 
gives you easy access to deadlines, book sales and other 
critical information.

LEARNYBK.COM
Here’s a shortcut to the online curriculum, which serves 
as a companion to our 12-booklet How to Yearbook printed 
curriculum. It is also accessible through the Learn menu on 
myHJYearbook.com.

HJESHARE.COM
Also available as an app, eShare is an easy way for parents and 
students to share photos with you.

YEARBOOKORDERCENTER.COM
Customized for your school, this is where students and 
parents order yearbooks and ads, access Online Ad Creator 
and upload photos. If you use the order center, remember to 
include the address and job number on your sales posters.
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KNOW WHERE TO FIND 
THE ONLINE RESOURCES 
TO CREATE YOUR BOOK



Herff Jones brought together two powerful online 
design tools to give you creative superpowers. With 
eDesign and Canva, you’ll see how cutting-edge 
design meets online innovation to make creating a 
yearbook easier and more exciting.

This is yearbook done right.

ABOUT CANVA
•	 Easy access from eDesign

•	 Cutting-edge photo editing

•	 Filters and effects

•	 Easily cut out backgrounds to create silhouettes

•	 Create content to place on yearbook spreads

•	 Generate infographics to support the story

•	 Dynamic text features let you get creative with 
typography

•	 Design in any language

•	 Thousands of templates and millions of graphics 
available at no cost

ABOUT eDESIGN
•	 Start with a Catalog full of Book Styles, mods and 

art to make building your yearbook a snap.

•	 Drag and drop elements into place, from 
templates to cover designs to Canva-generated 
art, it’s easy to organize and build. 

•	 Coverage reports, Staff Activity Reports and 
eBusiness reports all make an adviser’s job easier.

•	 Google integration lets users drag and drop from 
Google Drive or upload up to 100 photos at once.

•	 A single photo panel makes placing and cropping 
photos more streamlined.

•	 Custom color swatches let users create CMYK 
color blends and name them.

•	 Spellcheck, name check, and overset text, 
duplicate photo and DPI warnings — all work 
together to help you avoid errors.

•	 Benefit from built-in sales tools: Send and Sell for 
sending emails and eBusiness for tracking your 
book and ad sales.

It’s a great match

IF YOU CAN DREAM IT, YOU CAN BUILD IT. 
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GET READY FOR YOUR BEST YEARBOOK EVER.

We strive to make yearbook easy and 
straightforward. While there’s a lot to do, we’ve 
gathered the most critical get-it-done information 
into this handy guide. Follow this, and you’ll be in 
great shape. 

We know that yearbook programs come in all 
forms — clubs, small teams and large classes. 
Sometimes, it’s just one brave soul trying to put 
together the events of the year alongside all of 
those school pictures. As a yearbook adviser, 
you’ve got plenty of other important tasks to 
keep you busy. We get you, and we support your 
choice to do only as much as you choose. 

We’re here to help you break your jobs into 
bite-sized pieces and focus on making a fun, 
creative yearbook your school can be proud of. 

An adviser wears  
many hats…
1 — ES SEN T I A L T O - DOS  p.4

•	 Each school and situation is a little 
different. Here are four easy ways to 
make sure you are in the know and 
ready to plan your yearbook.

2 —P RODUC T ION B A SIC S  p.6
•	 Look for the yellow headlines for a 

beginner’s course to handling the 
basics of yearbooking, like uploading 
portraits and photos, designing pages 
and submitting them when you’re 
ready. There’s more support in our 
curriculum and online, but this is a 
great place to start.

3 —NE X T- L E V EL GO A L S  p.16
•	 If you have a club or a class, here 

are our suggestions for building a 
yearbook program that works for you 
and your school.

WE’RE 
GLAD 

YOU’RE
 HERE.



GET STUDENT AND FACULT Y NAME LISTS
Ask for a new list each year from your administrative 
office, and make sure it reflects new students, address 
changes, etc. Your school photographer will need this list, 
and if you use eBusiness or want to send email campaigns, 
you’ll need it, too. Request the following fields (not all are 
required, but could be helpful): 

•	 REQUIRED: First and last names (in separate fields; 
middle name is optional)

•	 REQUIRED: Grade 

•	 Full mailing address (separate fields for address line 
one, two, city, state or province and ZIP or postal code)

•	 Homeroom or identifying class period

•	 Student ID or another unique identifier

•	 Parent email address

Also, get a list of faculty and staff members.  
Request the following fields:

•	 First and last names (in separate fields)

•	 STA for staff or FAC for faculty in the grade field 

TROUBLESHOOTING:
If your front office questions your need for the student 
list, provide them with our FERPA policy, or PIPEDA/
FIPPA policy if you’re in Canada. These explain how Herff 
Jones is in compliance with laws related to using student 
information. Find them at herff.ly/sales-assist-how-to.

UPLOAD YOUR NAME LIST
Log in at myHJyearbook.com.
Go to Set up > Set up Sales.
Then click the Name List tab on the left.

IMPORT LIST TO EDESIGN
Log in at myHJyearbook.com.
Click the Settings tab, under School & Order 
Information, choose Name List. Check the box 
and tell eDesign to import it. Note: It may take up 
to 15 minutes for your name list to be available in 
eDesign after uploading to eBusiness.

If you need help, access the video tutorials under 
the Learn menu. And, if you really run into trouble, 
call your TSA for assistance.

PL AN YOUR FINANCES

 Refer to How to Yearbook and LearnYBK.com  
Section 11: Selling Your Book.

BUDGET

•	 Do you have a budget from the previous year?

•	 Set the yearbook price for parents and prices of 
add-ons, such as personalization.

BOOK SALES

•	 Do you sell books? If so, how many were sold  
last year? Account for books you give away, too. 

•	 Will you have one price all year or tiered pricing?

•	 Can you sell books at registration or  
back-to-school events?

•	 How will you promote your book?

AD SALES

•	 Will you sell ads to families, students and/or 
businesses?

•	 What price structure will you follow?

•	 How will you accomplish ad sales?

 
Once you get through all of the decisions for book and ad 
sales, you can set up eBusiness, the powerful business 
tracking software available only from Herff Jones. Go to 
MyHJyearbook.com and click on Set up > Set up Sales. 
Ask your rep or your TSA for help as needed. 

KEEP A CALENDAR
Make the rounds and find all of the dates that affect your 
school and your yearbook production schedule.

INCLUDE ON CALENDAR:

•	 Book sales events

•	 Picture day(s)

•	 Make-up picture day

•	 Club picture day(s)

•	 School activities (dances, rallies, assemblies)

•	 Theater/music/dance performances

•	 Club/organization events

•	 School holidays

IF YOU HAVE A YEARBOOK STAFF, ALSO INCLUDE:

•	 Staff work days/deadlines

•	 Cover design due date

ESSENTIAL TO-DOS
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all advisers and helpers start here

DECIDE WHAT TO INCLUDE
A yearbook serves as the official record of the school 
year. Your goal should be to include every student, faculty 
and staff member in the book as many times as possible. 
Although every book is different, here are some items you 
may wish to include:

BASIC COVERAGE:

•	 Individual portraits for students and faculty

•	 Club and organization photos

•	 Sports photos (if applicable)

•	 Major events of the school year

CHOOSE A COVER
You have the option of choosing a pre-designed cover, 
selecting a book style or designing your own. 

BASIC BOOK ELEMENTS:

•	 Cover: Theme, book title and year.

•	 Spine: As space allows, school name, city and state. 
Then, year and volume. Then, book name and theme,  
if it fits. (Doesn’t apply to soft-cover books.)

•	 Title page (page 1): Book title, volume number, 
year, school name, complete address, city, state/
province, postal code. Since you are creating a 
record of the year, it’s important to include the basic 
information here. Some schools include number of 
enrolled students and faculty/staff members.

ONLINE HELP 
Access through the Learn menu of MyHJyearbook.com

WHAT IF I  DON’T HAVE A YEARBOOK STAFF?
•	 Recruit parents or other school staff 

members to help you.

•	 Request assistance from teachers or 
counselors to help proof portrait pages.  
Their input on the correct spelling of names 
and identifying missing students is essential.

•	 Use Google forms to get great quotes from 
teachers or to conduct surveys with help 
from  teachers.

•	 Consider holding a photo contest to 
encourage student submissions.

•	 Feature student artwork or poetry.

•	 Use eShare to ask for photos.  
(See poster in this kit.)

•	 Consider forming a yearbook committee 
of parent helpers.

WHAT IF YEARBOOK IS A CLUB?
Yearbook clubs can be every bit as productive 
as yearbook classes. However, advisers have to 
motivate students with a force more powerful 
than grades. If you have a small staff, a club can 
supplement the staff’s work or allow students  
with packed schedules to get involved. 

SUGGESTIONS:

•	 Attend a workshop, summer camp or hold 
boot camp training sessions for staffers.

•	 Create an incentive system for staffers so they 
can earn a free book, a free ad or perhaps a 
discount on attending a workshop.

•	 Plan work nights when a deadline is looming. 
Have students bring part of a meal. Taco night, 
ice cream sundae bars, baked potato bars are 
all fun and simple.

•	 Consider offering membership in organizations, 
such as Quill and Scroll for high school, as a 
benefit to successful club participation.
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BUILD A L ADDER
In yearbook, the ladder is simply a chart that helps you 
plan what will go on each page and track progress. The 
ladder in this kit shows the maximum number of pages 
for your program. The number of pages is set in four-
page increments. Once you plan out your book, you may 
choose to move it all over to eDesign, if you wish, and 
include staffer assignments and deadlines. 

 Refer to How to Yearbook and LearnYBK.com  
Section Five: Covering Your School for more help.

SET UP YOUR LADDER IN EDESIGN

1.	Log in to eDesign: Go to myHJyearbook.com.  
Click on the Design menu and choose Pages.  
You’ll see all the spreads in your book with thumbnail 
previews and information about each page.

2.	Create topics and assign to pages: You’ll want to 
create topic tags for each page in your book. You can 
use these same topics to tag photos to save time. See 
the tutorial in eDesign Help on creating topic tags.

3.	Assign topics to pages: See the tutorial in eDesign 
Help on setting up the ladder.

4.	Assign deadlines and staff members: If you are 
working with a staff, assign each staffer to specific 
pages in the ladder. See the tutorial in eDesign Help 
on setting up the ladder.

EDESIGN LADDER

PRINTED LADDER

PRODUCTION BASICS
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STEP 1:  IDENTIF Y THE TOTAL NUMBER OF PAGES IN YOUR BOOK :     pages 

STEP 2: DETERMINE THE TOTAL NUMBER OF PORTRAIT PAGES YOU NEED

ELEMENTARY SCHOOL 

  # of pages for homerooms or classes 

+    # of portrait pages for other teachers, staff and administration

=    TOTAL # OF PAGES NEEDED FOR PORTRAITS

MIDDLE OR HIGH SCHOOL

# of ninth/sixth graders 	  divided by # portraits per page =    pages

# of 10th/seventh graders 	  divided by # portraits per page =    pages
 
# of 11th/eighth graders 	  divided by # portraits per page =    pages

# of 12th graders 	  divided by # portraits per page =    pages 
  
# of faculty/staff 	  divided by # portraits per page =    pages

                                     TOTAL # OF PAGES NEEDED FOR PORTRAITS  =   pages

STEP 3: CALCUL ATE HOW MANY YOU HAVE LEF T FOR OTHER TOPICS

  Total pages in your book 

–    Total number of portrait pages

=    PAGES REMAINING FOR ADDITIONAL CONTENT

                          Ex. 64 pages total – 22 portrait pages =  42 pages for additional content

STEP 4 : PL AN FOR IMPORTANT EVENTS
Make a list of all important events you’d like to include, the date they’ll happen, and the number of space 
you want to devote to them.

DATE	 EVENT		  AMOUNT OF SPACE IN BOOK

Ex. 8/24                  	 First day of school                               		   1/2 page

Ex. 9/15   	 Fall festival                     		  2 pages
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 Refer to How to Yearbook and LearnYBK.com Section Five: Covering Your School for resources.

everything you need to get started



PORTRAITS
THE PORTRAIT PROCESS
Portraits are incredibly important, so set aside 
plenty of time to ensure all portraits are included 
in the right grade or class and that all names are 
spelled correctly.

For help with the portrait section, begin with the 
People and Index section at LearnYBK.com, then 
check out the tutorials in eDesign help.

STEP 1: OBTAIN THE PORTRAIT FILE
Obtain the PSPA/PSPI file from your school 
photographer. Use the one made specifically for 
yearbook. Some photography companies send a 
CD, and others send a link to download the files.

STEP 2: UPLOAD THE PORTRAIT FILES
In the Portraits section of the eDesign Library, go 
to the Import/Export menu and choose Import 
PSPI File. You may need to create a ZIP file of the 
portraits before uploading. See the info box on this 
page for instructions.

STEP 3: FLOW THE PORTRAITS
Use eDesign’s Portrait Flow to place portraits 
and names onto the pages. It flows them in 
alphabetical order in groups you designate (by 
teacher or by grade). Do not put empty portrait 
frames onto pages first. eDesign does it for you. 

STEP 4: PROOF THE PORTRAIT PAGES
Either print the portrait pages or email low-res 
PDFs to teachers or others able to assist: 

•	 Any misspelled names?

•	 Any missing portraits? 

•	 Any portraits with the wrong names?

•	 Any student listed in the wrong grade/class?

There is also an option to print directory proofs of 
your portraits. See eDesign Help for more info. 

STEP 5: CHANGES IN PORTRAIT LIBRARY
After proofing, make all changes to portraits 
in the portrait section of the Library, NOT 
on the pages. See the instructions on editing 
portraits in eDesign Help for guidance. Use a 
consistent format for grades and teacher names. 
Teacher names are only needed if you plan to 
group students by teacher in the book.

STEP 6: RE-FLOW THE PORTRAITS
Open Portrait Flow again. A red alert will appear 
next to any group in Portrait Flow that needs to be 
re-flowed. Click Edit beside the portrait flow you 
need to re-flow. Portrait Flow remembers all the 
settings from when the section was last flowed. Re-
flowing the section will put the changes you made 
on the pages. Changes made in the Library will 
not go onto the pages until you re-flow.

For step-by-step instructions, refer to the 
portraits information in eDesign Help.

PORTRAIT FLOW WIZARD
The eDesign Portrait Flow wizard walks you through the process 
of placing portraits and names on pages. Select a page in the 
ladder, then go to Edit > Portrait Flow to launch.

You can now flow grades or a larger teacher photo.

NAME CHANGES IN PORTRAIT LIBRARY
Always make changes to names and grades in the Portrait 
Library. Then re-flow the section. If you make changes to 
names on pages, the changes will be lost if you re-flow.

FINAL CHECK BEFORE SUBMITTING  
Before you submit any portrait pages, go to the Portrait 
section of the Library and do the following:

1.	 Use the Filter menu at the top to filter by Unused.

2.	 Review the unused portraits to confirm they should not 
appear on pages.

3.	 If you discover any issues, make the needed changes and 
re-flow the affected sections.

PREPARING YOUR PORTRAIT CD FOR UPLOADING  
If you receive your portraits on a CD, you’ll need to create a 
ZIP file for uploading to eDesign:

1.	 Open the CD on your computer. 

2.	 Select the contents of the CD and copy ALL of the files to 
a folder on your local computer.

3.	 After the files copy over, right-click on the folder and 
choose Send To > Compressed (Zipped) folder. On Mac, 
control-click the folder and choose Compress.

PORTRAITS PRO TIP

CREATING A ZIP FILE
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PUT SOME BLING ON IT
Consider these enhancements to add value to your yearbook 
and to help generate income for your program. Contact your 
rep for ordering and pricing details.

PLASTIC JACKET
Hard-cover yearbooks 
stay protected and clean 
with these affordable 
plastic dust jackets.

AUTOGRAPH 
SUPPLEMENTS 
Eight-page autograph 
supplements can be 
added with Kleenstick®  
self-adhesive tape.

For more information, visit herff.ly/ybk-add-ons. 

NAME IMPRINT
A digital name imprint is a 
book personalization option, 
digitally printed on the cover. 
Printing student names on 
the cover leaves no question 
about whose book it is.

ENGRAVED  
NAME PLATES
Students can order metal 
plates engraved with 
their names and icons to 
customize their yearbook 
covers. Not recommended 
for soft cover books.

BOOK ENHANCEMENTS 
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WORLD YEARBOOK
Designed for middle/high school readers, 
this 16-page supplement documents events 
that made history during the school year. 

OUR WORLD
A scaled-down version of World Yearbook 
intended for younger readers, the four-page 
Our World supplement features photos and 
captions about this year’s most interesting 
news stories.

• If you purchase either of these for your entire 
order, you may choose where you want it to 
appear in your book (between signatures). If 
you don’t designate an insertion location, it 
will be added following the last page of your 
book. Smaller quantities are also available for 
purchase and come with Kleenstick® self-
adhesive tape for easy placement in the books 
when they arrive.



THE eDESIGN WORKFLOW FOR PAGES 
A page in eDesign passes through a few stages before it is 
submitted. These stages help you monitor progress and track 
what’s been done to each page.

 
No edits have been made. The page moves to the 
Edited stage after changes are made and saved on 
the page. Only the people assigned to the page or the 
adviser can edit a page. 

A page remains in this stage while the assigned staff 
members are working. When the page is complete, 
click the Pre-Submit link. 

In this stage, a page can only be unlocked by 
the adviser. Pre-Submit is the final step before 
submitting to the plant.

Always generate a high-res PDF of the 
final version of each page and carefully 
review it before submission. 

The PDF represents what will print, so be 
sure it appears as expected. This is your 
proof before submission.

The adviser has submitted the book to Herff Jones, 
and the page has begun its process at the plant.

WHEN IT  
NEEDS MORE WORK:  

Use the buttons in the 
ladder to move a page back 
to Edited to allow the staff 
member to edit it again.

BEFORE YOU SUBMIT
Your cover, personalization and all extras must be submitted at 
the same time as you submit the rest of the book.

UNEDITED

EDITED

PRE-SUBMIT

SUBMITTED

UNDERSTANDING PREFLIGHT 
Preflight Check in eDesign helps you in the proofing 
process by alerting you to potential issues. To run 
Preflight, go to the File menu when a page is open and 
choose Show Preflight Check. 

 

In Preflight Check, alerts appear in the vertical bars to 
the outside of each page. If you click on the alert, eDesign 
selects the item on the page that the alert references. If 
you hover over an alert, eDesign gives a brief description 
of the issue. The different alert types are described below. 

Preflight issues definitions: 

•	 Invisible content: If the page contains frames with 
no stroke, fill or content, you are given the option to 
delete the empty frames.

•	 Text across the gutter: Indicates a text frame that 
touches or crosses onto the adjoining page. Make 
sure no text will be lost in the gutter when the book 
is bound.

•	 Bleed object: Identifies an object that is very near 
the edge of the page but that does not fully bleed off 
the edge. Bleed elements must extend to the outside 
edge of the 1-pica red border around the spread.

•	 Picture box: Indicates an image that does not 
completely fill the photo frame.

•	 Image resolution: Appears when a photo’s 
resolution is too low for the highest print quality, 
indicating the photo will be fuzzy. A DPI warning 
also appears on the image.

•	 Transparency: Indicates images that have 
transparency applied. These images will not be color 
enhanced at the plant. You do not need to fix this. 
Preflight is just bringing it to your attention.

•	 Embedded image: Identifies non-JPEG images. 
These are not color enhanced at the plant. You do 
not need to fix this. Preflight is just bringing it to 
your attention.

•	 Placeholder text: Identifies placeholder text that 
has not been replaced with actual text.

WHEN A PAGE IS LOCKED

PADLOCK ICON: Only one person can edit a 
page at a time. A padlock indicates the page 
is currently being edited by another person. 
An adviser can “force unlock” a page from 
the ladder if needed.

PROOF. PREFLIGHT. SUBMIT.
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SUBMIT TING THE BOOK 
When all your pages have been proofed and are in the 
Pre-Submit stage, you’ll see the Submit Book button 
active at the top of the ladder. Click the Submit Book 
button and walk through the submission wizard to 
transmit your pages and order information to the plant.

Your ship date (when the book is complete and ships 
from the plant) is based on when you submit the book. 
To determine when to submit so you get the ship date 
you need, see the Ship Date Calendar at the end of this 
booklet. If you need guidance on when to submit, contact 
your Customer Service Adviser at the plant.

FILTER YOUR L ADDER
The Filter menu in the Book module allows you to filter your pages by 
their production states. Also helpful is the Show My Pages filter that 
allows staff members to see only the pages assigned to them.

SAVE IT FORWARD
After you submit your book, you’ll be given the option to transfer 
templates to the next year’s book. Be aware that all images, portraits, 
fonts, colors and art are transferred along with the template. You also 
have the option to use Save it Forward to transfer other settings such as 
your list of topics, ladder designations, staff, etc. Refer to eDesign Help 
for more information.

SUBMISSION DATE EARNED SHIP DATE NOTES

BY 1/2/23 1/28/23

1/3/23 TO 1/9/23 2/4/23

1/10/23 TO 1/16/23 2/11/23

1/17/23 TO 1/23/23 2/18/23

1/24/23 TO 1/30/23 2/25/23

1/31/23 TO 2/6/23 3/4/23

2/7/23 TO 2/13/23 3/11/23

2/14/23 TO 2/20/23 3/18/23

2/21/23 TO 2/27/23 4/1/23

PEAK SEASON

2/28/23 TO 3/6/23 4/8/23

3/7/23 TO 3/13/23 4/15/23

3/14/23 TO 3/20/23 4/22/23

3/21/23 TO 3/27/23 4/29/23

3/28/23 TO 4/3/23 5/6/23

4/4/23 TO 4/10/23 5/13/23

4/11/23 TO 4/17/23 5/20/23

4/18/23 TO 4/24/23 5/27/23

4/25/23 TO 5/8/23 6/3/23

5/9/23 TO 5/15/23 6/10/23

5/16/23 TO 5/22/23 6/17/23

5/23/23 TO 5/29/23 6/24/23

5/30/23 TO 6/5/23 7/1/23

6/6/23 TO 6/12/23 7/8/23

6/13/23 TO 6/19/23 7/15/23

6/20/23 TO 6/26/23 7/22/23

6/27/23 TO 7/3/23 7/29/23

7/4/23 TO 7/10/23 8/5/23

7/11/23 TO 7/17/23 8/12/23

7/18/23 TO 7/24/23 8/19/23

7/25/23 TO 7/31/23 8/26/23

8/1/23 TO 8/7/23 9/2/23

8/8/23 TO 8/14/23 9/9/23

8/15/23 TO 8/21/23 9/16/23

8/22/23 TO 8/28/23 9/23/23

8/29/23 TO 9/4/23 9/30/23

9/5/23 TO 9/11/23 10/7/23

9/12/23 TO 9/18/23 10/14/23

9/19/23 TO 9/25/23 10/21/23

9/26/23 TO 10/2/23 10/28/23

10/3/23 TO 10/9/23 11/4/23

10/10/23 TO 10/16/23 11/11/23

10/17/23 TO 10/23/23 11/18/23

10/24/23 TO 10/30/23 11/25/23

10/31/23 TO 11/6/23 12/2/23

11/7/23 TO 11/13/23 12/9/23

11/14/23 TO 11/20/23 12/16/23

11/21/23 TO 11/27/23 12/23/23

11/28/23 TO 12/4/23 12/30/23

12/5/23 TO 12/11/23 1/6/24

12/12/23 TO 12/18/23 1/13/24

12/19/23 TO 12/25/23 1/20/24

KEY PROGRAM 2023 SUBMIT/SHIP DATES

ALWAYS REVIEW A HIGH-RES PDF  
You generate PDFs from the File menu in 
Page Design and from the Export menu 
in the ladder. Use a low-resolution PDF for 
non-final quick proofs. A high-resolution 
PDF should be reviewed by the adviser 
before submission. Viewing a high-res PDF 
at 300 percent gives a good representation 
of the quality of images, etc. Be sure you’re 
happy with the appearance of the high-
resolution PDF. The PDF represents how 
the page will print. 

THE IMPORTANCE OF PROOFING



WORKING WITH IMAGES
Photos create the biggest impact in your yearbook, so you’ll want 
to collect the best. Refer to How to Yearbook and LearnYBK.com 
Section Seven: Cameras and Photos for more help.

PHOTOGRAPHY TIPS
DO set your camera’s image size to the appropriate settings.

•	 If you set it higher, your image will upload slowly, but you can 
make photos really large in the book.

•	 If you set it lower, your image will upload quickly, but you 
can’t enlarge photos much in the book.

DO make high-res PDFs and zoom in to 300 percent to see  
image quality.

DON’T take images directly off the internet or from someone’s 
social media site. There could be copyright and resolution issues.

DON’T ignore DPI warnings in eDesign on low-resolution images. 
Either make the image smaller on the page or choose another 
image for that spot instead.

CROWDSOURCE PHOTOS WITH ESHARE
Promote eShare and make photo requests in the school 
newsletter, via homeroom teachers, email or a note sent home 
with students. Include the eShare code on all advertising.

To set up eShare, go to MyHJyearbook.com > Transfer > Get 
Images from eShare > Preferences.

Use social media to request images of particular events. NOTE: 
You should NOT take images from Facebook or other social 
media sites for use in your yearbook. If you see an image you 
like, you can ask for the original and for permission  
to use it in the book. Also, don’t accept photos texted to you, 
request an email attachment for better quality. Remember files 
should be .jpg or .png. 

PHOTOGRAPHY POSTER found in the kit. 

eSHARE APP The eShare app is 
available in the App Store or the 
Google Play store.

IMAGE QUALITY 
The triangle means your photo will be fuzzy at the size it is on the 
page. Either choose a different photo or make the photo smaller.
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ORGANIZING YOUR IMAGES
Advisers and editors create the topic tags for the book. 
These tags should correspond to all the content topics in 
your book. Topics can be used in multiple ways to save time 
and keep you organized. 

Advisers and editors can create topics in the Topics panel in the 
Library, in the Topics panel in the Ladder and in the Topics area 
in Book Setup.

TOPICS HELP YOU BUILD YOUR LADDER
Topics are applied to pages in the ladder to designate the content 
of each page. Topic tags can be created by advisers and editors 
in the Topics panel of the ladder. Just create the topic tag (if it 
doesn’t exist) and apply it to the correct pages in the ladder.

TOPICS KEEP YOUR IMAGES ORGANIZED
Topics are like folders — but they’re better. Images can be tagged 
with more than one topic. That way a great image will appear 
for potential use on multiple pages (making the best use of your 
photos). The In Use indicator appears if an image is already used 
elsewhere so you can avoid duplicates. 

SHOWING YOUR TAGGED IMAGES
You can easily show the images tagged with 
a topic much like you open a folder on your 
computer. 

In the Library, go to the Topics tag panel and 
click the filter icon beside the topic to show 
only those images. 

THREE KINDS OF TAGS
Topic tags are essential for good organization, and you can add 
names and keywords for additional benefits:

1.	 TOPICS: Tag images with the same page topics you used to 
build your ladder.

2.	NAMES: Tag images with names in the Name List you 
import into eDesign.

3.	KEYWORDS: Tag images with extra information that might 
be helpful to you, especially more specific information (the 
event, the date, the opponent, etc.)

THREE WAYS TO UPLOAD IMAGES TO THE LIBRARY
Before uploading, decide which photos you’re most likely to use.  
It is best to limit uploads to the best photos.

1.	 IMPORT IMAGES: In the Candids section of the Library, 
go to the Import/Export menu and choose Import from My 
Device or Import from Google Drive. You can upload up to 
100 images in a batch.

2.	DRAG AND DROP:  In the Candids section of the Library, 
drag and drop images from your computer on the Library 
area. These images will begin uploading. You can upload up 
to 100 images in a batch.

3.	WHILE EDITING A PAGE:  When using the Candids section 
of the Library panel in Page Design, click the Add New 
option to upload images. You can also drag and drop up to 
100 images right to the Candids library panel while working 
on a spread. If the Library panel is filtered by Topic when 
uploading, that Topic will automatically be assigned to the 
newly imported images.

TOPICS: Ms. Smith’s Second Grade
NAMES: May Reddle, CeCe Smith
KEYWORDS: Oak Hill Farm field trip

GOOGLE INTEGRATION
You can upload from your computer or from your 
Google Drive. Go to eDesign Library >  
Import/Export > Import from My Device or 
Import from Google Drive.

IMAGES LIBRARY



DESIGNING PAGES
We offer a variety of predesigned layouts for both covers and inside pages. 
Activate them in the eDesign Catalog, and drag and drop them on pages. 
There are video tutorials in eDesign Help that show how to activate 
templates and how to put them onto pages. Then you can modify them any 
way you’d like. You may also create your own custom layouts.

STEP 1:  DECIDE WHICH L AYOUTS WORK BEST FOR YOU
We provide several layout collections to choose from. You can even mix 
and match if you wish.

•	 Book Styles — Our users who don’t want to start with a blank 
page, Book Styles include everything you need to build a beautiful 
yearbook, including templates and carefully matched fonts, color 
palettes, art and mods. Activate the Book Style of your choice 
through the Catalog. Book Styles are compatible with Square One.

•	 Square One – Our system for teaching graphic design basics, 
Square One templates and mods give you everything you need. 
Begin on paper, using our layout planning resources, or on screen. 
Go to the Layout and Design section of LearnYBK.com or ask your 
rep for more information about Square One.

•	 Trendy Topics and Bonus Books — During the pandemic, as 
students struggled to design their yearbooks in different ways, the 
many creative minds in the yearbook world went to work. These 
eDesign Catalog categories hold a wide assortment of additional 
resources for building a yearbook that suits your school. Load book 
sets or interrupter spreads and tweak them to make them your own.

STEP 2: ACTIVATE THE COLORS YOU WANT TO USE
Don’t pick colors based on how they look on screen nor based on how 
they look when printed from your desktop printer. These do not accurately 
show what colors will look like when printed on a printing press. 

Instead, look at the colors on the color poster. Make sure to refer to 
the poster that matches the paper you plan to use (gloss or matte).  
Each color has a CMYK code that matches colors in eDesign  
(for example, C=0 M=63 Y=73 K=0).

  C is cyan     M is magenta     Y is yellow     K is black (key) 

Make note of the CMYK numbers and activate those colors in  
Book Setup in eDesign. Watch Activating Colors in eDesign Help for more. 
When you add colors in eDesign, you can name them for easy reference.

STEP 3: CREATE CHARACTER ST YLES
You’re not required to use character styles, but they can be an easy way 
to apply consistent text formatting in your book. There are video tutorials 
in eDesign’s Help Menu that show how to create and use Character Styles.

EXAMPLE: 	 AHJ Chantilly Bold 	 24 pt.	 CMYK = 43, 12, 17, 87

	 Headlines	 font 	 pt size 	 color 

	 Subheads	 font 	 pt size 	 color 

	 Copy	 font 	 pt size 	 color 

	 Captions 	 font 	 pt size 	 color 

COLOR POSTER found in the kit. 

ONLINE HELP
eDESIGN HELP:
MYHJYEARBOOK.COM > LEARN

•	 Activating a Book Style

•	 Activating and Managing Fonts

•	 Creating Character Styles

•	 Activating and Creating Colors
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STEP 4 : IF DESIRED, PL ACE ART ON PAGES
You can put a background on the background layer of your 
page or spread so it doesn’t interfere with other elements 
on the page. To do this, select the background tool, drag and 
drop a background on an empty area of a page in eDesign. 

From there, you’ll see controls at the top to choose whether you want to 
work with a single page or the entire spread. Add a color fill, add an image, 
and even control the opacity of the entire background.

You can remove it by clicking the background tool in the tool panel and 
clicking the clear button at the bottom.

There are videos eDesign Help that show how to activate art in the Library.

STEP 5: ADD HEADLINES, COPY AND CAP TIONS AS DESIRED
eDesign has a time-saving tool called Caption Builder that allows you to 
easily add names in captions. When you tag images with names from the 
Name List, it will create text frames with correctly spelled names. Use 
that text frame to add a caption and format its font, color and style as 
you wish. There are video tutorials in eDesign Help that show how to tag 
images with names, how to spell check names in captions and how to use 
Caption Builder to create captions under photos.

When you place a template, the fonts, art and colors come with it. Then, 
it’s up to you to customize. Changing fonts and applying character styles 
is usually the first step. Square One mods include headline and copy 
packages set in a standard font. Once you choose and place these, you 
can change fonts and colors, and then add your own copy and photos.

FONT BOOK
AVA IL A BL E ONL INE AT herff.ly/font-booklet

•	 More than 500 fonts

•	 Explanation of types of fonts and 
tips for designing with fonts

SO MANY RESOURCES
AVA IL A BL E ONL INE AT herff.ly/ybk-resources

•	 On YearbookDiscoveries.com, 
there’s a treasure trove of resources 
just for you. Click on the Customer 
Resources menu at the top, and 
choose Premium Content. This 
area contains a huge number of 
downloads, from guides to covers 
and templates to social media 
graphics in the Sales and Promotion 
section. Be sure to look around. 
You’ll be amazed how much is here.



TAKE TIME TO TEACH
Use the first weeks of the school year to establish the skills 
and routines to empower students to do the heavy lifting 
in yearbook. Not sure where to start? Begin by reading 
the Welcome section of the curriculum. Then, access all 
of the online resources at LearnYBK.com. The curriculum 
bundle includes a scope and sequence document, which 
provides a sketch of how to teach yearbook skills. If you’re 
looking for something a little less intense, check out the 
quick-start guides posted on LearnYBK.com. You can also 
get to them by following this link: herff.ly/quickstart.

WHAT’S IN A THEME
Think of a theme as a storyline of the year. Themes provide 
visual and verbal unity for yearbooks. While they might not 
be obvious to every reader, a book with a theme presents a 
much better impression than a book without a theme. For 
theme development resources, see Section Four: Theme 
and Voice.

A GOOD THEME IS:
RECOGNIZABLE: Does it make sense as a framework for 
the whole book?

REFRESHING: Is it contemporary and different?

REPEATABLE: Can it easily appear on each theme spread 
without getting old? Can you come up with spin-off ideas?

REALISTIC: Is it appropriate to the students at your 
school this year? Does it relate to these students and this 
community?

RELEVANT: Is it relevant to each section of the book? Can 
the theme introduce each section without being forced? In 
20 years, will this theme seem relevant to the year in which 
it was produced?

If your theme is a storyline, think about what story you will 
tell. Here are some popular categories:

•	 We have a great reputation or legacy.

•	 We celebrate the individual as part of a larger group.

•	 We celebrate our group identity.

•	 Location. Location. Location.

•	 We’re all connected.

•	 Live in the moment.

MAKE YEARBOOK A CULTURE
If being on the yearbook staff is fun and rewarding, if 
students are aware of the skills they are building and able 
to see their own growth, smart students will flock to your 
door. OK, so maybe not flock, but they’ll want to see what 
it’s all about.

ESTABLISH STAFF TRADITIONS
Celebrate birthdays and holidays, recognize good work 
with simple awards. Work nights = food fests.

BE INCLUSIVE
Make room for visual students and verbal students, for 
organized kids who can handle the business side and 
chatty Cathys who just want to interview people. Recruit 
vibrant personalities and the kids sitting quietly in the 
corner. Make yearbook that much more special because 
it’s made for everyone.

JUST WHAT A NEWBIE NEEDS
We have resources curated especially for advisers 
who have just stepped into the world of yearbook. 
There’s so much to learn — and teach, if you have 
staffers — so these resources are meant for both 
uses. Visit herff.ly/newadviser. Check out the 
slideshows to learn the yearbook basics and then 
teach them to your students in the first weeks of the 
school year. You’ve got this!

EMPOWER YOUR EDITORS
Especially if your editors are returning to yearbook, give 
them teaching assignments. Put them in charge. When 
it comes to eDesign, there’s even a special document for 
editors. It walks them through the major tasks of the year. 
herff.ly/edesigneditors

AT TEND A WORKSHOP
Yearbook workshops are a great way for students to begin 
planning their book during their summer downtime.  
Go to herff.ly/ybk-events for more information.

YBK VIRTUAL SUMMER WORKSHOP
Herff Jones offers a virtual summer workshop. More 
information is available on YearbookDiscoveries.com.

NEXT-LEVEL GOALS
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USE YOUR RESOURCES
THE PRINTED CURRICULUM: Available through your rep 
or for order on herff.ly/ybk-shop. The curriculum bundle 
includes 12 booklets that break down the topics you need 
to teach.

LEARNYBK.COM: The online curriculum is divided 
into the same sections as the printed piece. You’ll 
find the supporting documents you need to complete 
the activities. From sample staff contracts and book 
sales forms to vocabulary quizzes and PowerPoints, 
LearnYBK.com is where you’ll find resources to make 
your own.

TOP FIVE TAKEAWAYS AND POWERPOINTS: On the 
inside front cover of most printed curriculum booklets, 
you’ll find a guide to the five most important points of each 
section. The PowerPoint presentations on LearnYBK.com 
match these takeaways.

VIDEO TUTORIALS: Access our ever-growing library of 
video tutorials through the Learn menu of MyHJYearbook.
com or the eDesign help button. Find guided notes in 
Section Nine: Tools of the Trade in the online curriculum.

ADVISER ASSISTANCE EMAILS: Make sure you’re 
getting these monthly emails from us. They’re filled with 
timely tips and tricks. We’re making sure you’ll never 
yearbook alone. 

MORE ONLINE RESOURCES: All of the online resources 
are available for a direct download from Google Drive. The 
link is included at the bottom of the Adviser Assistance 
emails. Also, answer keys to all of the lessons and quizzes 
are available at herff.ly/answerkeys. Cool, huh?

	           ADDITIONAL RESOURCES

if you have a staff, put them to work

MORE ONLINE
We make it easy for you, so you can focus on 
capturing the best memories for your school. 

Check out herff.ly/showcase and  
herff.ly/folio for inspiration and ideas. 



MAKE BOOK SALES EASY
Sales Assist is an email-based yearbook sales campaign 
designed to take the work out of reminding parents to 
purchase a yearbook. Following the best practices of 
online sales, reminders go to your list of parents a few 
times a month.

Once parents purchase a yearbook, they are automatically 
removed from the list. You may begin the campaign when 
you wish and stop it when you are ready. 

Parents buy online through YearbookOrderCenter.com, 
so you don’t have to handle money unless you choose 
to do in-school sales. And even then, the sales you enter 
in eBusiness are matched with the Sales Assist list, 
so parents no longer receive messages. Parents can 
also purchase by phone with the help of our customer 
service team.

Your MyHJYearboook.com portal gives you a real-time 
overview of how your sales are going and eBusiness allows 
you to print reports to help keep you in-the-know.

HOW IT WORKS

1.	 The campaign follows best practices for email 
sales. You can enroll when you are ready, and your 
list will be included in the next scheduled send. 
Unenrolling when you’re done takes just one call. 

2.	 Once parents make a purchase, they are excluded 
from future communications about book and ad 
sales. If you sell books in school and enter sales in 
eBusiness, those buyers will also be excluded from 
future emails. Make sure your eBusiness sales are  
updated regularly.

 
3.	 Posters are included in the kit so you can 

coordinate your in-school marketing with the email 
campaign. If you run out of posters, order more 
from herff.ly/ybk-shop. 

 
4.	 Go to the Premium Content Section of Yearbook 

Discoveries and check out all of the social media 
and web site graphics. Add them to your school’s 
web site, newsletters and other communications 
to parents.  
 

For more information, go to herff.ly/sales-assist.

FOLLOW THIS FORMULA TO FORMAT THE URL: 

yearbookordercenter.com/index.cfm/job/XXXX.  
Replace the XXXX with your job number. 

 
 

HOW TO ENROLL

1.	 Get a list of parents’ email addresses. (Mailing 
addresses are optional; see p. 4 for more.)

2.	 Contact your rep to enroll and help you upload 
your list.  

Keep your eBusiness records updated for best results. 

SEND AND SELL
In addition to Sales Assist, eDesign users can 
generate their own customized email campaigns. 
It pulls from your uploaded name and email list to 
send reminders to parents who have not purchased 
a book. Use pre-designed email messages or make 
your own. Click, click and you’re done. Check out the 
video tutorials under the eDesign Help menu. Don’t 
forget to enter your in-school sales into eBusiness, 
before sending.

ADDITIONAL TOOLS TO HELP YOU SELL 
Customize your marketing and sales efforts to fit your 
school. While we have included samples in this kit, 
additional resources are available on herff.ly/ybk-shop.
 
Posters, banners and yard signs help with: 

•	 Book sales

•	 Senior ad sales

•	 Price increases

•	 Distribution day

•	 General yearbook awareness

•	 Last chance sales

Letterhead
Order a stash of letterhead to send letters to 
businesses for ad renewals. 

SALES ASSIST
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SALES POSTERS (two designs available, found in the kit)

SALES BANNERS (seven designs available)YARD SIGNS

ORDER  
TODAY

DISTRIBUTION DAY SIGNAGE  

(three designs available)

SALES FLYER (found in the kit)

Find all these helpful items and more at herff.ly/ybk-shop.

S E R I O U S L Y,  D O N’T  M I S S  O U T !

0 0 0 - 9 0 3  ©  Herff Jones LLC

S E R I O U S L Y,  D O N’T  M I S S  O U T !

S E R I O U S L Y,  D O N’T  M I S S  O U T !

0 0 0 - 9 0 3  ©  Herff Jones LLC

B U Y  Y O U R  Y E A R B O O K  T O D A Y !

YE ARBOOKS MAK E
MOMENTS INTO

MEMORIES.

0 0 0 - 9 0 4  ©  Herff Jones LLC



Y E A R B O O K  O R D E R  F O R M
School/organization name: 

Principal’s name:  Adviser’s name:  Adviser’s email:   

School address:  City:  State/Province:  Zip/Postal: 

Phone:  Number of classrooms:  Copies:  Pages:  

We would like Herff Jones to print our all color yearbook based on the following information:

Determine per book base price: Number of books:  Number of pages:  = Per book price: 

To determine contract base price BEFORE book add-ons: Per book price:  x number of books:  = Contract base price 

ADD-ON ITEMS:
 Gloss lamination on all of our soft covers (+) price per book  x number of books  = + 

 Matte lamination on all of our soft covers (+) price per book  x number of books  = + 

 Upgrade to gloss laminated hard covers (+) price per book  x number of books  = + 

 Upgrade to matte laminated hard covers (+) price per book  x number of books  = + 

 Split covers: one-time fee of $  to mix soft and hard cover books  (+) one time fee = 

   Add  hard covers to our order (+) price per book  x number of books  = + 

 Upgrade to 100# gloss paper (+) price per book  x number of books  = + 

 Upgrade to 100# matte paper (+) price per book  x number of books  = + 

ADDITIONAL ITEMS:
 Add digital name imprints (minimum 25)  (+) price per imprint  x number of imprints  = + 

 Add name plates (minimum 10)  (+) price per plate  x number of plates  = + 

 Choose name plate color:   Silver   Gold 

 Add plastic jackets   (+) price per jacket  x number of jackets   = 

 Add Our World  copies  = 

   Sold individually @  each OR (+) price per copy  x number of copies  = + 

   Sewn into every book ordered @  each    (+) price per copy  x number of books  =  + 

 Add World Yearbook 

   Sewn into every book ordered @  each    (+) price per copy  x number of books  =  + 

  Total price after additions + 

  Total per book price  + BOOK SUBMISSION AND DELIVERY: 
We would like our kit to arrive on 

Our book needs to ship on Saturday, 

Our material must be submitted by Monday, 

Allow 4 weeks prior to ship date if your book ships before May. If your book will ship in May, allow 5 weeks from submission to delivery. Shorter schedules 
may be purchased. Kit materials will be shipped to the school address indicated above. 

Please allow 2-7 days for shipping. Plan your distribution event accordingly. Standard ground shipping is included. Expedited shipping is available 
at an additional cost.

TERMS AND CONDITIONS:
Years of printing:      20          20          20          20          20  
All specifications and prices are subject to the approval of both the school and Herff Jones, LLC, on an annual basis. We understand the submission of this order form is an obligation 
to print our yearbook as indicated above. We may change the number of copies and pages prior to, or upon submission of materials for printing; however, changes will result in a 
change in price. Upon receipt of our materials, we will receive an invoice for the full amount of this order form plus any increases or decreases due to changes in specifications. The full 
amount of the invoice is due upon receipt and must be received at Herff Jones prior to the shipment of our completed yearbooks. Standard ground shipping of the books is included in 
the cost. Tax is additional. We understand that copyrighted materials may not be used in the creation of our yearbook without the express written consent of the copyright owner. Herff 
Jones has created proprietary artwork, borders and backgrounds that may be used in the creation of our yearbook. We agree to hold Herff Jones, subsidiaries and affiliates harmless 
for all editorial content associated with the printing of our yearbook. I, the undersigned authorized agent of the school or organization indicated above, agree in full to the “Terms and 
Conditions” of this order. This agreement shall be effective when signed below or in counterpart, and photocopy, facsimile, electronic or other copies shall have the same effect for all 
purposes as an ink-signed original.

Authorized signature:  Title or position:  

Print name:  Date:  

Email:  Herff Jones representative: 

Complete this form and give to your rep, or fax 

to 913.441.6729. Call 800.255.6287 for assistance.

SAMPLE



SUBMISSION DATE EARNED SHIP DATE NOTES

BY 1/2/23 1/28/23

1/3/23 TO 1/9/23 2/4/23

1/10/23 TO 1/16/23 2/11/23

1/17/23 TO 1/23/23 2/18/23

1/24/23 TO 1/30/23 2/25/23

1/31/23 TO 2/6/23 3/4/23

2/7/23 TO 2/13/23 3/11/23

2/14/23 TO 2/20/23 3/18/23

2/21/23 TO 2/27/23 4/1/23

PEAK SEASON

2/28/23 TO 3/6/23 4/8/23

3/7/23 TO 3/13/23 4/15/23

3/14/23 TO 3/20/23 4/22/23

3/21/23 TO 3/27/23 4/29/23

3/28/23 TO 4/3/23 5/6/23

4/4/23 TO 4/10/23 5/13/23

4/11/23 TO 4/17/23 5/20/23

4/18/23 TO 4/24/23 5/27/23

4/25/23 TO 5/8/23 6/3/23

5/9/23 TO 5/15/23 6/10/23

5/16/23 TO 5/22/23 6/17/23

5/23/23 TO 5/29/23 6/24/23

5/30/23 TO 6/5/23 7/1/23

6/6/23 TO 6/12/23 7/8/23

6/13/23 TO 6/19/23 7/15/23

6/20/23 TO 6/26/23 7/22/23

6/27/23 TO 7/3/23 7/29/23

7/4/23 TO 7/10/23 8/5/23

7/11/23 TO 7/17/23 8/12/23

7/18/23 TO 7/24/23 8/19/23

7/25/23 TO 7/31/23 8/26/23

8/1/23 TO 8/7/23 9/2/23

8/8/23 TO 8/14/23 9/9/23

8/15/23 TO 8/21/23 9/16/23

8/22/23 TO 8/28/23 9/23/23

8/29/23 TO 9/4/23 9/30/23

9/5/23 TO 9/11/23 10/7/23

9/12/23 TO 9/18/23 10/14/23

9/19/23 TO 9/25/23 10/21/23

9/26/23 TO 10/2/23 10/28/23

10/3/23 TO 10/9/23 11/4/23

10/10/23 TO 10/16/23 11/11/23

10/17/23 TO 10/23/23 11/18/23

10/24/23 TO 10/30/23 11/25/23

10/31/23 TO 11/6/23 12/2/23

11/7/23 TO 11/13/23 12/9/23

11/14/23 TO 11/20/23 12/16/23

11/21/23 TO 11/27/23 12/23/23

11/28/23 TO 12/4/23 12/30/23

12/5/23 TO 12/11/23 1/6/24

12/12/23 TO 12/18/23 1/13/24

12/19/23 TO 12/25/23 1/20/24

KEY PROGRAM 2023 SUBMIT/SHIP DATES



There are a lot of steps to getting a yearbook done. We’re here to help.

W I T H  H E R F F  J O N E S ,  Y O U ’ L L  N E V E R  Y E A R B O O K  A L O N E .

0 0 0 - 9 1 6  K E Y  S Y 2 3  ©  Herff Jones LLC


